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Section 1

Overview of Chenille Embroidery

Chenille is a special type of embroidery using single (usually thicker) yarn instead 

of top thread and bobbin thread together. The word ‘Chenille’ is French, meaning 

‘caterpillar’.

Chenille is typically used for stitching letters on athletic jackets. It can be used 

alone, or combined with regular embroidery.

Chenille machine functions

Chenille machines can sew in two modes: Moss and Chain.

Moss stitching

Moss stitch uses looped yarn to sew. This stitch produces the typical Chenille 

raised stitching.

Chain stitching

Chain stitch is a decorative style of stitching which looks like the links of a Chain. 

It is used for outlining and bordering designs.
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Needle height

On some machines the needle height can be set in the design to control the height 

of the loop formed by the Chenille machine when it is sewing a Moss stitch, and 

the width (fatness) of the Chain stitch.

Moss can use different needle heights. You may use different needle heights for 

different color areas. You may also use different needle heights for filled areas and 

borders.

Needle height has much less effect on Chain stitches.

Chenille filling techniques

You can use both Moss and Chain stitch for outlines or shapes.

Run

To stitch single lines use Run with Chain or Moss. One or two offset run-arounds 

with Chain and Moss provide a clear edge for filled areas. 

Straight

Straight is similar to the Tatami used in regular embroidery. You can fill areas 

diagonally, or you can keep the fill lines horizontal and vertical. This is a matter 

of personal taste.
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Swirl

To fill columns or narrow areas, use Swirl fill with Moss. Swirl provides another 

way to fill an area with Moss stitches. The stitches are generated along curved 

lines.

 

For some machines, best results with Swirl are achieved by sewing in a 

counterclockwise direction. The reason for this is that as you sew in a clockwise 

direction, you are adding more twist to the yarn in the same direction that it was 

originally twisted. The added twist causes the yarn to become much tighter and 

distorts the Moss stitch loops.

Refer to your machine handbook for more details.

Lattice

To fill large areas with two layers of straight lines, use Lattice with Moss. Typically, 

the second layer of fill is perpendicular to the original fill. However, you may 

select a different angle. 

ideal loop extra-twisted yarn loop
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Contour Swirl Chenille stitch

To fill large Complex Fill objects, you can use the Contour Swirl Chenille stitch. 

The stitch is designed to mimic hand-Chenille embroidery. The swirl stitches are 

stitched in a spiral formation within the object.

This stitch type is available from either the Chenille toolbar or the Fill Stitch tab 

of the Object Properties dialog.
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Section 2

Chenille Embroidery with Punchant

The great innovation with Punchant is the move to object-based embroidery. 

This means that designs are created with all the information about each 

embroidery object stored in the design file, and accessible for full editing at any 

time. 

When Punchant designs are scaled up and down, the stitches are recalculated 

from the object outlines, which gives a result exactly as if it had been originally 

digitized at that size. Any of the properties of the objects can be edited, including 

the input points, start and end of stitching, all stitch type and effects parameters, 

even the color, and position in the design sequence.

Object-based Chenille

Object-based embroidery is also available for Chenille embroidery. This means 

that when Chenille designs created in Punchant are scaled, the stitches are 

automatically recalculated from the object outlines. Thus densities are preserved 

and there are no gaps or heavy over-stitching. Even the Chain and Moss 

boundary runs of Complex Fill areas are recalculated with the same offsets. 

Object outlines can be reshaped and the stitches are again recalculated to the new 

shape.

If you need to change the density of a design — for example to use a thinner 

thread — then you can simply edit the object properties. There is no need to 

redigitize.

Special Chenille stitches and effects

Chenille machines can stitch in either Moss or Chain, and with different needle 

heights. These machine functions are now treated as object properties in 

Punchant, much as color is. To change an object from Chain to Moss or vice 

versa, simply click on the tool. This is much easier than using machine functions.



6 Chenille Embroidery with Punchant V6

There are several special Chenille stitches in Punchant. Swirl is the stitching 

method typically used for narrow column shapes (Input A, B and C digitizing 

tools). A single layer of Straight stitch may also be occasionally used. 

The most common fill method in Chenille is Complex Fill, made with two layers 

of Straight stitch and called Lattice. This is usually done with the Compound 

Chenille effect, where multiple offset runs can be automatically generated from 

the same boundary as the fill. You can set up 3 offsets before and after the fill, 

each with your own values for the offset distances, as well as Chain, Moss and 

needle height. When the compound object is scaled, these offsets maintain all 

their values.

Note  The Smart Corners effect can be used with Straight stitch and Swirl for 

Input C objects. See Smart Corners in the Punchant User Manual for further 

details.

Compound Chenille

Compound Chenille is provided as a stitch effect for use with complex filled 

Lattice stitch embroidery objects. This feature is accessible from the Chenille 

toolbar or from the Stitch Effects dialog. It allows the automatic generation of 

offset runs associated with a Complex Fill shape before and after the fill area 

stitching. 

Offset runs can be set up to stitch with either moss or chain, at specific offsets 

and with specific needle heights. This feature provides productivity 

improvements for Chenille embroiderers.

Run direction in Compound Chenille

You can choose clockwise or counterclockwise direction for the offset borders in 

a Compound Chenille design. The correct stitching direction is important for 

Moss borders.

Chenille machines supported

Punchant supports Barudan, Tajima (old TMCE-100 and new TMCE-600 

models) and Melco Chenille machines. 

As with lockstitch designs, Punchant stores all the information about a design in 

the EMB no matter to which machine the design is output. Thus it is easy to write 

designs in different formats.
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Chenille quality features

Some of the key quality features for Chenille in Punchant are:

� constant stitch length in all objects: This is required for Chain and Moss to 

have a consistent smooth appearance.

� ability to control shortcut stitches: Some brands of Chenille machine have 

problems if the angle between one stitch and the next is too sharp. The 

Chenille shortcut angle will take care of this in many situations.

� variable width Swirl stitches for Input A and B methods: Swirl stitches 

automatically fill in the gaps at the ends of columns where there are fewer 

overlapping loops. Swirl is always stitched anti-clockwise, which gives best 

result for most thread types and machines. You are able to control whether 

the loops are circular or elliptical.

� Complex Fill generally handles small sections very well, especially where there 

is a tight fit with the offset runs.

� ability to generate multiple offset runs from one boundary, with or without a 

Lattice.

Digitizing Chenille designs for scaleability

Chenille designs usually have their own style and their own requirements for 

making good-quality scaleable designs. As with lockstitch designs, any Chenille 

design created in Punchant will be scaled from the outlines. But because parallel 

offset runs are used so frequently, Chenille users have to apply some thought and 

some special techniques to their digitizing.

As far as possible, Chenille designs and alphabets should be planned to use 

Complex Fill input with Compound Chenille to generate the offset runs. The 

offset runs can be generated in different colors. Punchant has made this far easier 

than it has ever been before.

Old Chenille designs

When an old Chenille design is read from expanded data (e.g. Melco EXP, Tajima 

or Barudan disk), the Stitch Processor in Punchant converts the stitching into 

objects. It does not fully recognise Swirl and straight stitching, so will be 

converted to a series of Run stitch objects. This limits the scaleability of these old 

designs to ± 5-10%.
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However old designs can be readily stitch edited and sections re-digitized if 

required.

Chenille toolbar

If you have a Chenille option added to your lockstitch Punchant system, you now 

have a single design window for both Chenille and normal embroidery. There is 

a special Chenille toolbar.

The Chenille toolbar contains special Chenille stitch types and machine 

functions, such as Straight, Swirl, Lattice, Compound Chenille, Chain, Moss, 

Needle Height. Compound Chenille allows you to generate Moss or Chain stitch 

run-arounds automatically for complex shapes.

Combined Lockstitch and Chenille designs

It is easy to make combined Chenille and normal embroidery designs. Objects are 

Chenille objects if they have a property of either Moss or Chain. A special 

Chenille template is also provided with combined systems. This automatically sets 

up all the values needed for Chenille.

Lettering and alphabets

Chenille alphabets are also able to be scaled. A selection of standard alphabets is 

included, both Swirl and Lattice filled alphabets. The alphabets are used just like 

lockstitch alphabets, except that they must be used with the ‘As Digitized’ joining 

method.

You can create custom Chenille alphabets if you have the User-Defined 

Alphabets feature. Similar care in designing the letters is required for scaleability 

of alphabets as for other Chenille designs, and very good results can be achieved.

Other information

TrueView™

TrueView™ does not display Chain and Moss stitching. However, it can still be 

useful to give an impression of the design when viewed at a small zoom factor 

(less than 1:1).
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Trim

Many Chenille machines do not have an automatic trimmer as the connecting 

threads are under the fabric and are not visible. In this case, digitize all the shapes 

and lines of the same color in one session to minimise the number of manual 

trims. This will reduce the time required to stitch the design. Be careful how you 

connect from one spot to another. Avoid long connecting stitches which may pull 

the previous stitching and may need to be trimmed.

Jump

The use of jumps is not recommended. Due to the pulling effect on the fabric 

during a jump, the design may be distorted, especially if the fabric is thin. To avoid 

long connecting stitches, plan carefully in which order you digitize the shapes and 

lines.

Use Chain stitch instead of Jump when traveling across a shape filled with Moss 

stitching. The Chain stitch will usually be hidden inside Moss stitching. If there is 

a significant contrast in colors, particularly if the current stitch is of a lighter color, 

then the yarn will not be hidden successfully. In this case use Jump.

Small stitches

Avoid very small and empty (non-data) stitches. Small stitches are not suitable for 

Chenille because the Chenille yarn is usually thick. They may cause yarn breakage 

or holes in the fabric.

Avoid pointed objects as they produce small stitches. Use Chain stitches for tie in 

and tie off stitching.

Overlocking

Overlocking prevents the stitches unraveling if the stitching is Chain. You need 

to manually insert a Chain for Barudan and Melco Chenille machines. Tajima 

machines can change automatically from Moss to Chain if the machine has this 

option enabled.

Overlaps

Do not overlap sections as in regular embroidery. The yarn is too thick.
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Corners

Avoid sharp corners. Chain stitch will bulge at sharp angles.

Punchant automatically adds an extra stitch to avoid sharp corners within objects, 

including manual stitch objects. If you round off sharp corners in run and 

Complex Fills, you can avoid both sharp angles and small stitches. Also, fill stitch 

angles should be chosen so that sharp angles with the fill boundaries are avoided.

Chain/Moss visual feedback

Any design containing Chenille embroidery objects can be viewed in a special 

mode allowing easy identification of Chain and Moss design elements. With the 

design open within the Punchant Designer, select the Chain/Moss menu item 

from the View menu list. The design will now be displayed in three colors which 

identify lockstitch embroidery objects (green), Chenille chain elements (blue) and 

Chenille moss elements (red).
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Section 3

Creating Chenille Designs

Digitizing Chenille designs is very similar to digitizing regular embroidery 

designs. First select a Chenille embroidery machine, then digitize the design color 

by color, shape by shape using Chenille stitch types and machine functions. 

Note  Artwork must allow for thicker thread and offset runs.

To create a Chenille design

1. Start Punchant Designer.

2. Choose New from the File menu and select a Chenille template from the 

New dialog box.

The Chenille template defaults the system to Chenille values.You can 

modify the template to suit your machine. See Modifying a template in the 

Punchant User Manual for further details.

3. Choose Select Machine Format from the Machine menu and select a 

Chenille machine.
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4. Click the Values button on the Select Machine Format dialog box.

5. Select values to suit your Chenille machine. See Selecting Machine Format 

Values on page 15 for details.

6. Set the Shortcut Angle and Minimal Stitch values as required. See Selecting 

Shortcut Angles and Minimal Stitch Values on page 13 for details.

7. Click OK.

8. Click either the Chain or Moss button on the toolbar.

9. Choose Swirl, Straight or Lattice stitching types from the toolbar or from 

the Stitch menu.

10. Change the stitch values and effects if required.

See Selecting Stitch Values on page 19 for details.

11. Click Compound Chenille on the toolbar to generate automatic Moss or 

Chain stitch borders if required.

See Generating Borders around Filled Areas on page 27 for details.

12. Digitize shapes and lines using various input methods: Manual, Run, 

Complex Fill, Input A, Input B, Input C.

• Use Complex Fill with Straight or Lattice. 

• Use Input A, B or C with Swirl for narrow, turning columns. 

• Use Run for lines, borders and details.

See Digitizing a box on page 31 for details.

13. Save your design.

14. Output the design to disk, tape, or send it directly to a Chenille machine for 

stitching.

See Outputting Designs for Chenille Machines on page 35 for details.



V6 Punchant User Manual Chenille Supplement 13

Selecting Shortcut Angles and Minimal Stitch Values

Some Chenille machine types require that the angle between one stitch and the 

next is not very sharp — e.g. Tajima Chenille machines require it to be at least 60º.

Chenille Shortcut filters are provided to avoid small stitches and sharp changes in 

stitch direction during Chenille stitch generation. Parameters for these filters are 

user definable and accessible from within the Machine Format Values dialog of 

Chenille machine types. These filters operate only on Chenille stitch types and 

have no effect on lockstitch stitch types.

Punchant automatically applies the shortcut angle to all cover stitches inside an 

object. However connections between travel stitches and offsets and fills are not 

always checked. Also, the Shortcut is not applied to connecting stitches and 

jumps between objects. 

Note  Non-EMB embroidery format Chenille designs can be shortcut-checked 

when opened in Punchant by clearing the Outlines/Objects checkbox.

To select Shortcut Angle and Minimal Stitch values

1. Choose Select Machine Format from the Machine menu and click the 

Values button on the Select Machine Format dialog box.

Alternatively select Machine Format Values from the Machine menu.

2. In the Standard tab of the Machine Format Values dialog, set the Shortcut 

Angle and Minimal Stitch values as required.

3. Click Save and then Close.

Set Shortcut Angle and 

Minimal Stitch values.
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4. Click OK.

Design Checker

A design checker is provided for the identification of Chenille Shortcut Angle 

violations. The design checker is activated by hot key CTRL + K. The stitch cursor 

will jump to the first stitch which violates the Chenille shortcut angle. You must 

correct this problem by stitch editing. You must then press the hot key 

combination again for the software to detect any problems further into the 

design.
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Section 4

Selecting Machine Format Values

The Machine Format values dialog box contains two tabs — Standard and 

Advanced. The Standard tab includes values related to basic embroidery machine 

functions. The Advanced tab includes further technical details. Change the values 

in the Advanced dialog box only if you are familiar with the codes used by your 

embroidery machine. See Customizing machine format values in the Punchant User 

Manual for further details.

Chenille Minimal Stitch and Shortcut Angle

Some Chenille machine types require that the angle between one stitch and the 

next is not very sharp — e.g. Tajima Chenille machines require it to be at least 60º.

The Chenille Minimal Stitch and Shortcut Angle avoid small stitches and sharp 

changes in stitch direction during Chenille stitch generation. This filter operates 

only on Chenille stitch types and has no effect on lockstitch stitch types.

Punchant automatically applies the shortcut angle to all cover stitches inside an 

object. However connections between travel stitches and offsets and fills are not 

always checked. Also, the shortcut is not applied to connecting stitches and jumps 

between objects.

Note  Jumps in Chenille stitching after changing shortcut angle or minimum 

stitch value are no longer present.

You can use the shortcut key (CTRL + K) to jump to the first stitch which has a 

shortcut angle problem. You can then fix the problem by editing the stitch. To 

jump to the next stitch with the problem, use the shortcut key again.

Note  Non-EMB embroidery format Chenille designs can be shortcut-checked 

when opened into Punchant by clearing the Outlines/Objects checkbox.
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Barudan Chenille

Barudan Chenille does not have boring values and the maximum frame 

movement is 4.0 mm. It has Minimal Stitch and Shortcut Angle option. All other 

machine values are the same as the standard lockstitch Barudan.

Melco Chenille

Melco Chenille has the same machine format values as the standard lockstitch 

Melco except that it has Minimal Stitch, Shortcut Angle and Explicit value option. 

Check the Explicit value if you want to use the needle heights selected in the 

design. Uncheck the Explicit value to select the needle heights manually on the 

machine.

Tajima TMCE-600

Tajima TMCE-600 has the same machine format values as the standard lockstitch 

Tajima except that it has Minimal Stitch and Shortcut Angle option.

Tajima TMCE-100

Tajima TMCE-100 does not have boring. It has Minimal Stitch and Shortcut 

Angle option. All other machine values are the same as the standard lockstitch 

Tajima.

Tajima Chenille and Tajima Chenille Multi-Stop

The Tajima Chenille machines have three functions — Chain, Moss and Color 

Change. The Tajima code system does not have specific codes assigned to these 

machine functions; it uses empty stitch (non-data) and stop codes instead. 

There are two different types of Tajima Chenille machines, which use different 

combinations of empty stitch (non-data) and stop codes to indicate these 

machine functions. The stitch data you output from Punchant must be different 

depending on which type of machine you are using. Punchant provides two 

different Tajima Chenille machine formats, so that you can easily output a 

Chenille design for stitching on either machine.

The older — Tajima TMCE — model uses different combinations of multiple 

stop codes and empty stitch (non-data) codes for the chain, moss and needle 

height functions. As each Chenille function is coded differently, this machine can 

recognize them. The old Tajima TMCE machine is often referred to as the 

‘multi-stop’ Tajima Chenille machine. If you intend to stitch a design on one of 
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these machines, make sure that you select the ‘Tajima Chenille multi-stop’ 

machine format. The chain, moss and needle height functions will be 

automatically converted to the correct combinations of empty stitch and stop 

codes used by these machines.

The new Tajima TMCE-S Chenille machine only uses single stop codes for 

switching between chain and moss stitching. These machines cannot distinguish 

between the functions, so you need to select a function for each stop at the 

machine, in the same way as you select needle numbers for color stops. If you are 

using one of these machines, select the Tajima Chenille TMCE-600 machine 

format. Each chain, moss and needle height function will be output as a single 

stop code.

Condition file

When using TMCE-600 format and saving a design as a DST file, a condition file 

(*.cc0) is saved alongside the design. This file contains information that the 

machine can read so that the setup process is partially automated.

From
Change 

Color

Change 

Needle 

Height

To Function Codes

Machine Setup 

For Needle 

Height

Chain � � Chain stop -

Chain � � Chain stop set new height

Chain � � Chain stop-empty-stop set new height 2

Chain � � Moss stop-stop -

Chain � � Moss stop-stop-stop-

stop

-

Chain � � Moss stop-stop set new height

Chain � � Moss stop-stop-stop-

stop

set new height 2

Moss � � Moss stop-stop -

Moss � � Moss stop-stop set new height

Moss � � Moss stop-stop-stop-

stop

set new height 2

Moss � � Chain stop-stop -

Moss � � Chain stop-empty-stop -

Moss � � Chain stop set new height

Moss � � Chain stop-empty-stop set new height 2
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Start of Design/End of Design

Choose the starting stitch type.

When starting with chain stitching, an empty stitch (non-data) code will 

automatically be inserted at the start of the design.

When starting with Moss stitching, an empty stitch (non-data) and a stop code 

will be automatically inserted at the start of the design.

Do not digitize two Empty Stitches at the beginning of the design, as this will 

affect registration. Avoid using Empty Stitches elsewhere in the design.

Other Tajima Chenille values are the same as the standard lockstitch Tajima 

machine values.
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Section 5

Selecting Stitch Values

Stitch length should be constant for the same thread type throughout a design. If 

the stitch length varies, the height of the Moss loops and the width of the Chain 

loops will also vary, providing uneven embroidery. The Chenille machine pulls up 

the same length of yarn for each loop according to the current needle height 

setting.

If you intend to use loops of various height, adjust the needle height rather than 

the stitch length. Even though the stitch length affects the loop height, it is easier 

and more accurate to adjust the needle height.

Select a stitch length for a design according to the thickness of the yarn, the 

thickness of the fabric and the required density. Using inappropriate stitch length 

may cause yarn breakage, needle breakage and damage to the fabric. 

Note  If the yarns in use are of the same type, the lengths of the Chain and Moss 

stitch are different. The following table gives an indication of appropriate values.

Tip  These values may vary depending on the fabric used. When you use a new 

thread and fabric combination, sew a test design first using the above values as an 

initial guideline.

Thread 

Type

Rayon 

300d/2P
Miki Wool

Woolly 

Yarn

Cotton 

Thread #12

Softaine 

G

Chain 

Stitch 

Length

2.0-3.0 

mm

2.5-3.5 

mm

1.8-2.2 

mm

2.3 mm 2.0 mm

Moss Stitch 

Length

1.5-1.7 

mm

2.0-2.2 

mm

1.6 mm 2.1 mm 1.7 mm

Moss Stitch 

Spacing

1.5 mm 1.8 mm 1.7 mm 1.5 mm 1.8 mm
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Swirl stitch

Swirl is the stitching method typically used for narrow column shapes (Input A, 

B and C digitizing tools). Swirl generates consistent stitch length even over 

different widths. It can be generated with either closed or open end.

Pressing ENTER after the shape is digitized generates Swirl with closed end.

Pressing SPACE after the shape is digitized generates Swirl with open end. This is 

useful for joining objects.

To select Swirl stitch values

1. Choose Object Properties from the Stitch menu or from the toolbar.

2. In the Object Properties dialog box, click the Fill Stitch tab.
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3. Choose Swirl from the dropdown list beside the Stitch Type.

4. Change the Stitch Length, Swirl spacing and Swirl Width as required.

5. Click OK.

Straight stitch

Straight stitch can be used with any input methods. Usually straight stitch is used 

with either Input A, B and C to fill the shape with Chain. It is recommended for 

Complex Fill input method to fill areas with Moss. All the stitches generated 

along a row are of same length. However, some shorter stitches are generated 

where the shape is narrow and between rows of stitching.

Swirl spacing

Swirl width

stitch 

length
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To select Straight stitch values

1. Choose Object Properties from the Stitch menu or from the toolbar.

2. In the Object Properties dialog box, click the Fill Stitch tab.

3. Choose Straight from the dropdown list beside Stitch Type.

4. Change the stitch length and spacing as required.

5. Click OK.

Lattice stitch

The most common fill method in Chenille is Complex Fill, made with two layers 

of Straight stitch and called Lattice. The angle of the first layer is defined by 

Complex Fill input method. Typically, the second layer is usually perpendicular to 

the original fill although you may select a different angle.

Stitch

Length

Stitch Spacing
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To select Lattice stitch values

1. Choose Object Properties from the Stitch menu or from the toolbar.

2. In the Object Properties dialog box, click the Fill Stitch tab.

3. Choose Lattice from the dropdown list beside Stitch Type.

4. Change the stitch length, spacing and angle of second layer as required.

5. Click OK.

Contour Swirl Chenille stitch

The Contour Swirl Chenille stitch can be used to fill large Complex Fill objects. 

The stitch is designed to mimic hand-Chenille embroidery. The stitches are 

placed in a spiral formation within the object.

angle of second 

layer

stitch 

length

stitch spacing
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This stitch type is available from either the Chenille toolbar or the Fill Stitch tab 

of the Object Properties dialog.

To select Contour Swirl values

1. Choose Object Properties from the Stitch menu or from the toolbar.

2. In the Object Properties dialog box, click the Fill Stitch tab.

3. Select Contour Swirl from the Stitch Type dropdown list.

4. Set the stitch length, spacing, width, height, and overlap values as required. 

These parameters are the same as those specified for other Chenille stitch 

types such as Swirl.
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5. Click OK.

Swirl height

stitch length Swirl spacing

Swirl overlap

Swirl width
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Section 6

Generating Borders around Filled Areas

Compound Chenille effect generates multiple offset runs automatically from the 

same boundary as the fill. You can set up 3 offsets before and after the fill, each 

with your own values for the offset distances, as well as Chain, Moss and needle 

height. When the compound object is scaled, these offsets maintain all their 

values. 

You only digitize the complex shape once, then the stitches are generated 

according to the current Compound Chenille values. 

To generate offset boundaries for Complex Fill objects

1. Choose Object Properties from the Stitch menu or from the toolbar.

2. Click the Effects button on the Object Properties dialog box.

3. In the Effects dialog box, click the Compound Chenille tab and check 

Compound Chenille.

Choose Effects.
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4. Decide how many offset boundaries you want to generate before the shape 

is filled.

Before Fill Offset 1, 2 and 3

Offset 1, 2 and 3 allow you to stitch multiple offset boundaries of the shape 

with either Moss or Chain. The stitch boundaries are generated first, before 

the fill stitching. They hold the fabric in place and provide clearer edge 

definition for shapes. Offset Moss or Chain stitch generated inside the 

shape are used to define the shape, while outside Offset Moss or Chain 

stitch may be a highlight.
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Offset (Units)

Offset specifies the distance between the digitized boundary and the Offset. 

To generate parallel Offsets inside the shape, enter a positive value, for 

example 1.5 mm. To generate Offsets outside the shape, enter a negative 

value, for example -1.5 mm.

Needle Height

Needle Height controls the height of the loop formed by the Chenille 

machine when it is sewing a Moss stitch, and the width (fatness) of the 

Chain stitch.

5. Decide if you want to fill the shape with stitches.

Stitch Fill

Stitch Fill allows you to fill the digitized shape. If it is unchecked, the shape 

will not be filled at all. 

Fill Offset Distance

Fill Offset Distance specifies the distance between the digitized boundaries 

and the filled area. It is always measured from the digitized boundary, not 

from the last Offset Moss or Chain Stitch. The edge of the filled area can be 

on the digitized boundaries, or it can be inside or outside. You may also 

stitch the fill to an Offset Moss or Chain stitch border. If you enter 0.0 mm, 

the edge of the filled area will be exactly on the digitized boundaries. If you 
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enter a positive distance value, the edge of the filled area will be inside the 

shape. If you enter a negative distance value, the edge of the filled area will 

be outside the shape.

6. Decide how many offset boundaries you want to generate after the shape is 

filled.

After Fill Offset 1, 2 and 3 

Offset 1, 2 and 3 allow you to stitch multiple offset boundaries of the shape 

with either Moss or Chain. The stitch boundaries are generated after the fill 

stitching. They hold the fabric in place and provide clearer edge definition 

for shapes. Offset Moss or Chain stitch generated inside the shape are used 

to define the shape, while outside Offset Moss or Chain stitch may be a 

highlight.

Offset (Units)

Offset specifies the distance between the digitized boundary and the Offset. 

To generate parallel Offsets inside the shape, enter a positive value, for 

example 1.5 mm. To generate Offsets outside the shape, enter a negative 

value, for example -1.5 mm.

Needle Height

Needle Height controls the height of the loop formed by the Chenille 

machine when it is sewing a Moss stitch, and the width (fatness) of the 

Chain stitch.

7. Select the outline stitch length.

Outline Stitch Length allows you to set the stitch length for either Moss or 

Chain stitch boundaries.

8. Select the number of overlapping stitches between the offset runs.

Overlapping Stitches allows you to shift the connectors between Offset 

Runs by a few stitches to prevent stitches building up at the joins. Also, the 

connectors are less visible if they are not in one line.

2 overlapping stitches
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9. Click OK.

Exercise 1: Digitizing a box

Shapes can be digitized using two different methods. 

Digitizing a box with Input A, Input B or Input C

With the first method you digitize the shape with Input A, Input B or Input C, 

then digitize the run-arounds using Complex Fill with Compound Chenille effect. 

Digitize narrow, turning shapes with Swirl. 

To digitize a box with Input A, Input B or Input C

1. Prepare the drawing.

Choose an artwork suitable for Chenille embroidery. Avoid artworks which 

have lots of tiny detail. Chenille is fairly coarse compared to regular 

embroidery.

If you are using a digitizer tablet, first you need to prepare an enlargement 

drawing of the artwork. Many designers find that it is best if the enlargement 

drawing is 3 to 6 times larger than the finished embroidery and if the 

drawing scale is an exact multiple of the finished size, e.g. 3:1, 4:1, 6:1.

2. Choose Stitch Type > Swirl or Straight from the Stitch menu or from the 

Chenille toolbar.

3. Choose Moss from the Chenille toolbar.

4. Digitize the box.

Choose Input A, Input B or Input C. Digitize the actual outline of the 

drawing.

5. Generate stitches.
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6. Right-click Compound Chenille on the toolbar and set the properties in the 

Effects dialog.

• Set the offsets(1-6) in the Compound Chenille effect dialog box to a 

negative value.

• Uncheck Stitch Fill because it is not necessary to fill the shape. The shape 

is already filled using the Input A method.

See Generating Borders around Filled Areas on page 27 for details.

7. Digitize the box again.

Choose Complex Fill Input and digitize the actual outline of the box.

8. Generate stitches.

The offset run-arounds are generated.
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Digitizing a box using Complex Fill

You can digitize shapes with Complex Fill, which allows you to generate two 

layers of fill and several offset run-arounds automatically. Use this method 

whenever possible because it is faster and you do not need to draw parallel lines 

for the run-arounds on the artwork or enlargement drawing. As you scale the 

design, the offsets are recalculated with the same distance spacing from the fill.

To digitize a box using Complex Fill

1. Choose Lattice from the Stitch menu or from the Chenille toolbar.

2. Choose Moss from the Chenille toolbar.

3. Right-click Compound Chenille on the toolbar and set the properties in the 

Effects dialog.

stitch angle

W Y

XZ
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See Generating Borders around Filled Areas on page 27 for details.

4. Digitize the box.

Choose Complex Fill Input and digitize the actual outline of the box.

5. Generate stitches.

6. Digitize the top left corner of the box (W) as entry point and the bottom 

right corner (X) as exit point for the first fill. 

7. Digitize 45° stitch angle.

The stitches are generated if Generate Stitches is turned on.
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Section 7

Outputting Designs for Chenille Machines

Chenille designs can be output to an embroidery floppy disk, can be punched to 

a paper tape or can be sent directly to an embroidery machine if connected to the 

computer.

Barudan Chenille machines

When writing the design to a Barudan Chenille embroidery disk, simply select 

‘Barudan’ format. Before outputting check that the Jump stitch length is within 4 

mm.

Tajima Chenille machines

There are two different types of Tajima Chenille machines. The old ‘multistop’ 

TMCE-100 machine uses different combinations of multiple Stop Codes and 

Empties for Chain, Moss and Needle Height functions. The new Tajima 

TMCE-600 Chenille machine only uses single Stop Codes for switching between 

Chain and Moss stitching.

If you are using an old ‘multistop’ machine the Chain, Moss and Needle Height 

functions will be automatically converted to the correct combinations of Stop 

Codes and Empties.

When writing the design to a Tajima embroidery disk, simply select ‘Tajima DST’ 

format. Before outputting check that the shortcut angle is set to 60°.

Melco Chenille machines

When writing the design to embroidery disk, simply select ‘Melco EXP’ format.
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Section 8

Creating Combined Chenille and 

Lockstitch Designs

Chenille designs can be converted to any machine format, including lockstitch 

machines. This is useful when you wish to combine regular embroidery and 

Chenille embroidery in a single design.

To create combined Chenille and lockstitch designs

1. Plan your Chenille and lockstitch design.

2. Mark a reference point in the design. This should be the common start point 

for both Chenille and lockstitch designs.

3. Digitize the Chenille part of the design.

4. Save two copies of the design.

5. Open the second copy.

6. Choose Select Machine Format from the Machine menu and select a 

lockstitch machine format.

The design is converted to the selected machine format. The Chenille 

specific functions, such as Chain, Moss and Needle Height, are preserved 

but they are ignored by the lockstitch machines.

7. Digitize the lockstitch parts.

For correct registration, make sure that the start point of the lockstitch part 

exactly match the start point of the Chenille part.

8. Save the combined design.

9. Delete the Chenille parts, and save the lockstitch part under a new name. 

Now you have two designs, a Chenille and a lockstitch design with matching 

start and finish points.

10. Stitch the Chenille part first on a Chenille machine — Barudan, Melco or 

Tajima.
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Which part you stitch may vary, depending on the design.

11. Stitch the lockstitch part on the same brand of machine.

As the hoops are standard within the same brand, you can remove the hoop 

from the first machine and insert it in the other. As they have matching start 

and finish points, the two designs will be perfectly aligned.

Note  Tajima TMCE-600 is a combined Chenille and lockstitch embroidery 

machine. Combined Chenille and lockstitch design can be output to this 

machine from a single file.
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Section 9

Reading Chenille Designs from Disk

When you read a design from an embroidery disk, they are converted from 

embroidery file format to EMB format. The Chenille functions appear in the 

converted design in the same way as they are stored in the embroidery format file, 

or on the paper tape. Chenille designs cannot be distinguished from normal 

embroidery designs automatically. The system maintains the previous setting. So 

it is not necessary to select the Machine Format in the Decoding Options dialog 

box, if you want to read an embroidery file with the same Machine Format as the 

previous.

Barudan format file

To read a Barudan Chenille design

1. Choose Open for DOS formatted disk or Embroidery Disk > Open for 

Embroidery disk from the File menu.

2. When the Open dialog box appears, select Barudan FDR, FMC or T03 

from the Files of Type dropdown list for DOS formatted disk. For 

embroidery disk select Barudan from Designs of Type dropdown list of 

Open From Embroidery disk dialog box.

3. Click the Options button.

4. When the Decoding Options dialog box appears, select Barudan Chenille 

from the Machine Type dropdown list.

5. Click OK.
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Tajima format file

To read a Tajima Chenille design

1. Choose Open for DOS formatted disk or Embroidery Disk > Open for 

Embroidery disk from the File menu.

2. When the Open dialog box appears, select Tajima T01, or DST from the 

Files of Type dropdown list for DOS formatted disk. For embroidery disk 

select Tajima DST from Designs of Type dropdown list of Open From 

Embroidery disk dialog box.

Note  In Tajima TMCE-600 all Chenille functions stops are interpreted as 

color change.

3. Click the Options button.

4. When the Decoding Options dialog box appears, select Tajima TMCE-100 

or TMCE-600 from the Machine Type dropdown list.

5. Click OK.

Melco format file

To read a Melco Chenille design

1. Choose Open for DOS formatted disk or Embroidery Disk > Open for 

Embroidery disk from the File menu.

2. When the Open dialog box appears, select Melco EXP from the Files of 

Type dropdown list for DOS formatted disk. For embroidery disk select 

Melco EXP from Designs of Type dropdown list of Open From 

Embroidery Disk dialog box.

3. Click the Options button.

4. When the Decoding Options dialog box appears, select Melco Chenille 

from the Machine Type dropdown list.

5. Click OK.
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Section 10

Chenille Embroidery Lettering with 

Punchant

The Chenille option for Punchant allows you to create Chenille lettering. A 

selection of Chenille alphabets is provided with the software which can be scaled 

and recolored like other alphabets. You have the option of creating your own 

alphabets as well.

Chenille alphabets have some special requirements related to the Chenille filling 

techniques:

Letter Size

Some Chenille alphabets are made to suit a particular letter size and one type of 

thread (thickness) only. The size of these alphabets cannot be successfully varied 

by more than 5-10% from that recommended. You cannot change the stitching 

parameters (stitch length, spacing, etc) of these alphabets at all.

Other Chenille alphabets have been designed for use within certain size ranges 

and of these some Lattice alphabets allow object properties such as stitch length, 

spacing and offsets to be varied.

See Chenille alphabets on page 45 for size recommendations for each Chenille 

alphabet.

Fill stitch type

The fill stitch type cannot be changed when the letters are used in a design, as 

Straight and Swirl require different filling techniques. For example, if an alphabet 

was digitized with Straight, the shapes are probably filled with two perpendicular 

layers, which cannot be stitched with Swirl.

Chain and Moss

When creating Chenille lettering, you must specify Chain or Moss stitch. The 

properties of the offset runs are not saved in the alphabet.
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When digitizing a Chenille alphabet, you can insert Chain and Moss properties. 

They are saved in the alphabet.

Needle Height changes

When digitizing a Chenille alphabet, you can insert Needle Height. All letters in 

the alphabet must have the same number (or a multiple) of needle height changes.

Connection

Chenille alphabets use either As Digitized, Closest Join or Bottom Join method.

Creating Chenille lettering designs

Digitizing Chenille designs is very similar to digitizing regular embroidery 

designs. Creating Chenille lettering is similar to creating other lettering. First 

select a Chenille embroidery machine, then digitize the design color by color, 

shape by shape, and letter by letter using Chenille stitch types and machine 

functions.

Note  Artwork must allow for thicker thread and offset runs.

To create a Chenille lettering design

1. Start Punchant Designer.

2. Choose New from the File menu and select a Chenille Template from the 

New dialog box.

Chenille template defaults the system to Chenille values. You can modify 

the template to suit your machine. See Modifying a template in the Punchant 

User Manual for further details.

3. Choose Select Machine Format from the Machine menu and select a 

Chenille machine.

4. Click the Values button on the Select Machine Format dialog box.

5. Change Shortcut Angle and Minimal Stitch values as required and close the 

dialog. See Selecting Shortcut Angles and Minimal Stitch Values on page 13 for 

details.

6. Click either the Chain or Moss button on the toolbar.

7. Choose Stitch Type > Swirl, Straight or Lattice from the Stitch menu or 

from the Chenille toolbar.

8. Change the stitch values and effects as required.
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See Selecting Stitch Values on page 19 for details.

9. Choose a Chenille alphabet from the alphabet dropdown list on the 

Lettering toolbar.

10. Create your letters with the Lettering tool on the Punch/Edit toolbar.

11. If not already selected, click the Compound Chenille button on the toolbar 

to generate automatic Moss or Chain stitch borders as required.

See Contour Swirl Chenille stitch on page 23 for details.

12. Save your design.

13. Output the design to disk, tape, or send it directly to a Chenille machine for 

stitching.

See Outputting Designs for Chenille Machines on page 35 for details.

Creating your own alphabets

Digitizing Chenille alphabets is similar to digitizing lockstitch alphabets. 

However, Chenille alphabets are not as flexible as lockstitch alphabets. They have 

some special requirements related to the Chenille filling techniques.

If you want to make an alphabet to be used at one size only and with one type of 

thread (thickness) only, then there are no restrictions. Use any valid stitch types, 

and any input method. When you make your alphabet, be sure to uncheck the 

Remove Functions checkbox in the Make Letter dialog box.

Designing scaleable alphabets and changing density due to different threads 

require some thought and understanding of the way both Punchant and Chenille 

work. Lattice alphabets are the easiest. 

For an alphabet to be successfully scaleable (like any Chenille design), the offset 

runs around the shapes must maintain the same distance from fill in after scaling 

up or down. This can only be achieved if the offsets are generated by Compound 

Chenille effect — the stitches are recalculated from the object outline, using the 

same properties no matter what the size.

Note  Chenille alphabets with Swirl and Compound effect are possible because 

multiple stitch types can be stitched in lettering. See Keeping original stitch values in 

the Punchant User Manual for further details.

Chenille Alphabet using Compound Chenille and Lattice 

It’s very simple to make a scaleable alphabet and to change actual stitch 

parameters using Compound Chenille and Lattice. If you want to change the 
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stitch parameters and the compound offset values when you use the alphabet, you 

must make sure that every object has the same values when you initially create the 

alphabet. It doesn’t matter what these values are but they should be same for all 

objects. This also means that you cannot use Run or any other digitizing tool to 

create additional stitching in the letters.

Chenille Athletic Block is the alphabet style available in V5.1. Alphabets created 

using Chenille Athletic Block style are scaleable. The style automatically converts 

lowercase letters to uppercase. Characters A through Z and numbers 0 through 9 

can use this style. The stitch values can be edited as each character contains only 

one object.

The alphabet is digitized using Complex Fill method. It is filled with Lattice 

stitching and Compound Effect. Recommended height for the alphabet is 

between 2 and 6 inches. Recommended connection type is either As Digitized or 

Closest Join.

Scaleable alphabets

For scaleable alphabets, the compound offsets must have either the same 

boundary as the fill (i.e. Stitch Fill is checked in the Compound dialog), or else 

their boundary is in exactly the same position as the fill objects boundary. This 

technique gives you two possibilities.

� Firstly, you can digitize the body of letters in Input A and Swirl, and then 

digitize a separate Complex Fill around this, using the exact outlines of the 

Swirl as your guide. This Complex Fill has Compound effect — the offsets 

should have a negative value not positive as is usual, so that they fall outside 

the Swirl fill. And of course Stitch Fill in the Compound dialog is unchecked, 

since you already have a Swirl fill. 
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� The second use of multiple objects with the same boundary is to make 

multi-color Chenille alphabets which again are scaleable. For example, one 

object has the very outside offset in the first color in Chain, then there are 

other objects in a second color which make up the inside Chain/Moss offsets 

and the fill.

Alphabets created this way are scaleable, but you cannot change the stitch length, 

offset distances or any other stitching parameters. However, if you digitize all the 

letters in an EMB file and keep them, you can change individual object properties 

in the EMB and ‘re-make’ another variant of the alphabet to suit a different 

thread and density.

Chenille alphabets

The following table lists the Chenille alphabets provided with Punchant and their 

recommended size ranges:

Alphabet Sample

 Recommended Sizes

Min Max

ins mm ins mm

Chenille 

Altheltic 

Block

1.5 40 4 100

Chenille 

Griz

1.5 40 4 100

Chenille 

Hatten

2.5 60 6 150

Chenille 

Impact

2 50 5 125
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